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1 Browser Extension Manual

Welcome to the Passwordstate Browser Extension Manual.

The Click Studios Browser Extensions for Passwordstate enables the secure storing of
website credentials in your Passwordstate instance. These credentials can then be used to
automatically form-fill the credential input fields, such as the username and password fields,
when you next visit that sites URL (Uniform Resource Locator) or web address.

The Browser Extensions are currently available for all Chromium based browsers, including
Google Chrome, Microsoft Edge, the Brave Browser and Mozilla’s Firefox.

The following table summarizes each of the key areas for configuring and using our
Passwordstate Browser Extensions.

™ Note: Our Browser Extensions require you to have cookies enabled in your browser

Prerequisites How to configure Passwordstate ready to save credentials

Installation How to install the Browser Extension, and configure for use
Browser Extension Explains the various settings for the Browser Extension

Settings

Browser Extension Provides instructions for basic usage of the Browser Extension for
Usage Chromium based browsers and Firefox

Web Authentication Instructions for using Passkeys with web sites and Passwordstate
Passkeys

Detection and Provides guidance on issues with certain web sites not prompting to
Advanced save login credentials

Functionality

2 Prerequisites

In order to use our Browser Extensions, you'll need to have the following:

1. A supported Web Browser. The Passwordstate Browser Extensions are available for all
Chromium based browsers, including Google Chrome, Microsoft Edge, the Brave Browser
and Mozilla’s Firefox,
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2. Aninstallation of Passwordstate, on a host matching our webserver requirements
https://www.clickstudios.com.au/passwordstate-system-requirements.aspx, that you can
log into, and,

3. One or more Password Lists in Passwordstate, that have the URL field enabled.

To create a new Password List with the URL field enabled, create a new Private or Shared
Password List based on the Web Site Logins Template:

Search Passwords or Hosts ... d)

Q, ‘ B ‘ (] ‘ 8 Click Demo

Passwordstate vos euid o5

PASSWORDS

Passwords

Passwords Home

Add Folder

Add Private Password List
Add Shared Password List
Administer Bulk Permissions

Expiring Passwords Calendar

& Add Private Password List Wizard

To create your Private Password List, please specify details below and select the type of Password List you would like based off the
available Templates.

Password List Details Confirmation

Password List Templates
Site Location: Eﬁ Internal

Pending Access Requests

Password List: * lPerscna\ Website Logins l

Request Access to Passwords

Toggle All Password List Visibility Description : [
Template: Web Site Logins T
Image: () websitepng M

Template Description: ~ Store web site logins, which can also be used with Browser Extensions feature

O Link this Password List to the selected Template. O Disable future use of this Wizard

Cancel

Note: Additional settings can be changed after the Password List has been created.

Alternatively, you can edit an existing Password List and enable the URL field under the
customize fields tab:
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PaSSWO rdState V9.5 (Build 9577) Search Passwords or Hosts ... Q ‘ E ‘ C\ ‘ 8 Click Demo LI)
= PASSWORDS ‘
QR 3 ) ) )
Edit Password List Properties
Passwords Home
» =7 An Example To edit the details for the selected Password List, please fill in the details below for each of the various tabs

4 P~ Browser Extension Manual

[@ Pcrconal Website Logins password list details customize fields quide api key & settings
T Business Systems Below you can specify which fields are available, which ones are required fields, and select one or more Generic Fields and
T Customers & configure

- their options accordingly.
Infrastructure

T Personal Password Lists Standard Fields
F5 Backup Accounts

»
»
»
»

Field Name Required  Hide Column @
Title
User Name @] O
Description @] [m]
O Account Type (@] @]
URL O 0
Password O
Password Strength m]
Expiry Date O @]
Notes (@]
Generic Fields (click on Field Names to rename)
Field Name Required  Encrypt Hide Field Type
Column @
(O Generic Field 1 @] @] 0 Text Field N
O Generic Field 2 O O O Text Field M

3 Installation

Please follow these steps for installing and configuring our Browser Extension. The majority
of the screenshots provided in this manual have been taken using the Brave Browser with
the Browser Extension obtained from the Chrome Web Store. The screenshots for Chrome,
Edge and Firefox look similar to those of the Brave Browser.

™ Note 1: In order to use one of the Browser Extensions, to save and automatically form-fill

credentials for websites, you must have access to one or more Password Lists configured to
use the 'URL' field.

™ Note 2: Our extensions support websites with multiple login fields, not just the typical
username and password input fields. A total of 13 input fields can be catered for by using

the Username, Password, OTP (enabled at the Password List Level) and up to 10 Generic
Fields.

™ Note 3: Click Studios does not provide a Browser Extension for the Apple Safari browser.
We recommend using Chrome on Apple MACs as a work around if required.
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Brave Installation

1. Visit the Google Chrome Web Store URL
https://chrome.google.com/webstore/category/extensions and search for the extension
name Passwordstate.

Alternatively, you can download it directly from
https://chrome.google.com/webstore/detail /passwordstate/appojfilknpkghkebigcdkmop
dfcjhim

Click the Add to Brave button to install the extension, then click the Add Extension
button

e~ chrome web store

a Signin

Home > Extensions > Passwordstate

_M_ Passwordstate

& www.clickstudios.com.au

% W K 14 @ | Productivity | 50,000+ users

Overview Privacy practices Reviews Support Related

Passwordstate @ Chrome Browser Extension

oce

3. Once installed, you should see the Passwordstate icon in the top toolbar
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¥ A —_— 0k B

4. If you don’t see the Passwordstate extension, click on the Extensions button and pin the
extension as per the screen shot below:

4 = O X

@ A O) w2 =

. X dios »
Extensions
Full access

These extensions can see and changgfinformation on
this site.

Passwordstate n =

£ Manage extensions

Chrome Installation

1. Visit the Google Chrome Web Store URL

https://chrome.google.com/webstore/category/extensions and search for the extension
name Passwordstate.
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Alternatively, you can download it directly from

https://chrome.google.com/webstore/detail/passwordstate/appoijfilknpkghkebigcdkmopd

fcihim

2. Click the Add to Chrome button to install the extension, and click the Add Extension
button. The images for this will appear very similar to those for the Brave installation in

the section above.

3. Once installed, you should see the Passwordstate icon in the top toolbar.

4. If you don’t see the Passwordstate extension, click on the Extensions button and pin the

extension as per the Brave Installation image.

Edge Installation

1. Open Microsoft Edge and browse to

https://microsoftedge.microsoft.com/addons/detail /passwordstate/pbbamlchainnpdodbeobf

pgcpffpclka?hl=en-US and click the Get button:

Help ~  Developers v All Microsoft ~ (}1;\

B Microsoft | Edge Add-ons®™
Home / Productivity / Passwordstate
Passwordstate
Click Studios Pty Ltd
* %k Kk (9) ‘ 100,000+ Users ‘ Productivity
Description

Passwordstate For Edge is a free form filler extension that obtains credentials from Passwordstate.

No user reviews

Sortby | Most recent Add a review

No one has reviewed this add-on yet. Be the first to add a review.

(e

Compatible with your browser

Details
Version 9.493
Updated April 6, 2022

Available in 1 language

Terms

Privacy policy

Developer
More add-ons from Click
Studios Pty Ltd

Report abuse

2. Click the Add extension button:
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\ Add "Passwordstate” to Microsoft Edge?

The extension can:

» Read and change all your data on all websites
» Display notifications
- Modify data you copy and paste

1  Add extension

3. Once installed, you should see the Passwordstate icon in the top toolbar Similar to the
Brave installation image.

Firefox Installation

1. Visit the Mozilla Add-ons store URL https://addons.mozilla.org/en-US/firefox/ and search
for the extension name Passwordstate.

Alternatively, you can download it directly from https://addons.mozilla.org/en-
US/firefox/addon/passwordstate-password-manager/

2. Click the Add to Firefox button
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Firefox Add-ons Blog  Extension Workshop .  Developer Hub @ Log in

$s Firefox Browser
{ ADD—ONS Extensions Themes More... v

5

Passwordstate Password Manager 4

by Click Studios .

A This add-on is not actively monitored for security by Mozilla. Make sure you trust it before 1
installing.

Passwordstate for Firefox is a form filler extension that obtains Add to Firefox R

credentials from Passwordstate.

Rate your experience Screenshots

How are you enjoying Passwordstate Password
Manager?

Log in to rate this extension

Report this add-on for abuse =
22 Passwordstate ) Firefox Browser Extension

3. Click the Add button

A+ Add Passwordstate? This extension will have permission to:

e Access your data for all websites
e Input data to the clipboard

¢ Display notifications to you

» Access browser tabs

Cancel
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4. Once installed, you should see the Passwordstate icon in the top toolbar similar to the
Brave installation. You may also receive the following prompt

A~ Passwordstate was added.

Manage your add-ons and themes through the application
menu.

Allow this extension to run in Private Windows

Simply click Okay to close this prompt.

Your extension is now ready to configure for the first time, and more information about this
can be found in the Browser Extension Usage section of this manual.

4 Browser Extension Usage

This section of the manual applies to our Chromium based browsers and Firefox Extensions.

Configuring the Browser Extension

Prior to using the browser extensions, you must go to your Preferences screen, and specify a
Master Password to be used for authentication.

& Preferences

To modify your preferences for account , please make changes in the relevant tabs below, then click on the 'Save' button.

passwords tab hosts tab miscellaneous color theme authentication options mobile access options

ce your extension is installed, all you need to do is login to Passwordstate, and the extension

Browser Extension Master Password

Please specify your Mast word for using the Bpae®er Extensions feature. The password must be used to authenticate your extension, before it can be used

Browser Extension Master Password:
Master Password saved to database | Clear

Clear Clipboard Settings

Please specify settings below for automatically clearing the clipboard via the Browser Extensions.

When your Browser Extension is first installed its icon will show as red, indicating it is not
currently configured and syncing with your Passwordstate instance. Note, it will also show
as red if your Browser Extension is currently logged out.
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-

Passwordstate X + - () X

v
q c @ A e /logins/loginadan.aspx? @ A . 02
L

m

Passwordstate

Manual Login Authentication

Login

Please enter your user name and Password to authenticate

Username v

Password

Status: Awaiting Login

If you click on your extension, you will see a message advising that you need to browse to
your Passwordstate website which will initiate the connection process:
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> 171

Browser Extension Authentication (Extension Build 9783)

Please browse to your Passwordstate Website, or refresh the
screen if already logged in. so this extension can be configured.

When the extension icon is red you are not authenticated,

If the icon is yellow you are required to unlock with your Master
Pazsword and when the icon turns black or blue, you can begin
using this feature (blue means an Ignored URL).

Your Passwordstate Website must also be using a Trusted 551
Certificate for this extension to work. Please refer to
documentation for further information.

To connect your extension to your Passwordstate instance, first browse to your
Passwordstate URL, and log in. You will receive a message asking you to click on the
Passwordstate browser extension. Click the "OK - 1 Understand" button, and then click on
the red Extension icon:

h Passwords or Hos

— & Passwordstate Browser Extension Authentication

@ Please click on the Passwordstate Browser Extension
icon in the browser toolbar above to proceed with

authentication.
OK - | understand

de B Strength Policy word Strength Summary

[ - S
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You will then be presented with a pop up asking to confirm the URL is correct, and to enter
your Master Password. Please ensure this is the URL you use to log into Passwordstate with
every day, specify your Master Password, then click on the "Login" button to finish the
connection process:

e *
. Browser Extension Authentication (Extension Build 9783)

1

1
@ https://}

You must enter your Master Password, as sef on your
Preferences -»> Browser Extension screen, and confirm the URL
above is correct.

Master Password: |

The Browser Extension will now connect to your Passwordstate instance and authenticate
using the credentials you logged in with. Your Browser Extension icon will now turn blue.

™ Note: You are asked to confirm the Passwordstate website URL is correct as mitigation
against a phishing style attack, where you could be asked to click on a link to login to an
imitation of your Passwordstate environment. If you believe the URL is suspicious in anyway,
report this to your Passwordstate Security Administrators.

ICON Status

Our Browser Extensions use different colors as a quick visual indicator or status of the
Browser Extension. The 4 different colors and their meanings are,

This indicates the Browser Extension is active and authenticated to your Passwordstate
instance. It also indicates the URL on the active tab in your browser is set to be ignored by
the Browser Extension. Ignored URLs will not automatically form-fill existing, or prompt to
save new, credentials for that website. By default, your Passwordstate URL is an Ignored
URL.
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&3 This indicates the Browser Extension is active and authenticated to your Passwordstate
instance. When the icon is black you are able to automatically form-fill any saved
credentials for a website. You will also be prompted to save any new credentials you enter
while on a website. These credentials are saved to your Passwordstate instance that you are
authenticated against.

This indicates the Browser Extension is not active. Itis either logged out of your
Passwordstate Instance, or requires the initial configuration to point to the correct
Passwordstate instance’s base URL. In both cases, simply browse to your Passwordstate
website login URL and login as normal. This will authenticate the user if they are logged out,
or prompt to confirm the URL presented is the same as your Passwordstate instance’s base
URL.

Your browser extension is in a "locked" state, and you will need to unlock it using your
Master Password.

User Interface

The Browser Extension interface provides a range of features and options. The following
image is taken using the Brave browser, with the Browser Extension loaded from the Google
Chrome Web Store.
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-

Passwordstate x 4+ ¥ a sl S
q C @ n B pass @ A % 0 =
Passwordstate (guiid 9577 kDemo | ()
= .
QR T *  passwords Home 3 screen Options ® - e Wb 1
asswordstate Web Site
[ Generate Password
An EBxample Q Search All Pass 8 g
4 P~ Browser Extension Manual
- Actions  Title Tree Path Description A\ Preferences bt
(.9 Personal Website Logins :
No records found or you must enter some search criteria. ;
T Business Systems @ Ignored URLs (2) »

T Customers #

¥ Password Statistics

v
»
v T Infrastructure
»

T Personal Password Lists @ Report Site Issue

B Backup Accounts 160 N A © Sync Now (sync scheduled in 58 minutes) |

_ e @ Help

Q ® Logout: Click Demo

120

Aug 2021  Sep2021 Oct2021 MNov 2021 Dec2021 Jan2022 Feb2022 MWar2022 Apr2022 May 2022 Jun 2022 Jul 2022
W All Users Events: m My Events

A Search box, which can be used to quickly search for website credentials across all Password
Lists you have been granted access to

A link directly to your Passwordstate website

Generate Password, by clicking this you can generate random passwords with different
complexities. This is highly recommended when creating new passwords for a website

Preferences - more about this is explained below

Ignored URLs —again, more information is provided later in this manual

Report Site Issue, If the browser extension is not automatically form-filling a website, or does
not capture the log in credentials correctly for you, you can use this to report it directly to Click

Studios for testing

Sync Now, which allows you to immediately resynchronize your Browser Extension and pickup
any changes made to permissions and credentials within Passwordstate

A link to open the Browser Extension Help Manual

Logout button, used to disconnect your extension from your account in Passwordstate
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Preferences

On the Preferences screen you have five options:

r

Infrastructure

Passwordstate X + v - g x
d C @ M & pass @ A * O =
Search Passwords or HosfleSl 4 Back kDemo | (b
PASSWORDS ‘ A, Preferences
- a .
% -
QR T * Passwords Home  ::i screen Options ° Enable Auto-Fill
° Enable Icon Overlay
» =7 An Example .
P! Q Search All Passwori pefault Password List
4 I~ Browser Extension Manual X X X
X Actions  Title Tree Path Description \Browser Extension Manual\Personal Web v | ite
(L) Personal Website Logins .
- No records found or you must enter some search criteria
» 7 Business Systems Default Password Generator
» 77 Customers & e Default Password Generator v
N I Password Statistics
»

T Personal Password Lists

FZ Backup Accounts 160 A A

120

Aug 2021 Sep 2021 Oct2021 Nov2021 Dec2021 Jan2022 Feb2022 Mar2022 Apr2022 May2022 Jun2022 Jul 2022
W All Users Events: B My Events

1. A Back Button to return to the main page

2. A check box to Enable Auto-Fill on websites. With this enabled your Browser Extension will
automatically form-fill credential input fields. Disabling this will prevent the Browser
Extension from automatically form-filling login credentials on any website you visit. You can
manually force the Browser Extension to fill the credentials while this is disabled

3. The Enable Icon Overlay when enabled will insert the Passwordstate heartbeaticonin all
credential input fields. This can be clicked on to select the correct credentials for that site.
When disabled it prevents the browser extension icon in the login fields on all websites

4. The Default Password List drop down allows you to select which Password List all new login
credentials will be saved to. If you have multiple Password Lists with the URL field configured,
you can still choose another Password List to save credentials to at the time of saving them

5. The Default Password Generator allows you to set a Password Generator of your choice from
those available to you in Passwordstate. This is then used by the Browser Extension to
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generate new random passwords in accordance with the selected generator’s complexity
settings

Saving Log in Credentials

When logging into a website for the first time with your Browser Extension active, you will be
presented with a page asking if you want to Add Site to Passwordstate? This will save the
credentials into Passwordstate if you haven’t already saved then. It won’t ask you to save them a
second time.

I Passwordstate

Add Site to Passwordstate?

Mo www.imdb.com

Password List

\Browser Extension Manual\Personal We v

Username

Description

IMDb Sign-In

Password

On this screen you have the option to choose which Password List to store the data into, and
the Username, Description and Password fields are editable prior to clicking Save. Use the
magnifying glass icon to toggle the visibility of the password if required.

Clicking on the Later button will not save the credentials to the Password List this time.
Instead, you will be prompted to save the credentials the next time you login to that website.

Clicking on the Never button will save the URL as an Ignored URL in Passwordstate. This
will prevent the Browser Extension from asking you to save your login credentials for that
website. It will also prevent automatic form-filling for this website even if you have other
credentials already saved.

Ignored URLs are saved under your personal Preferences in Passwordstate. If needed, URLs
can be removed from or added to your Preferences, or from within the Ignored URLs option
on the main Browser Extension screen.

Auto-Filling Login Credentials
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When you visit a website that you have a credential already saved for, the Browser Extension
will display a number in red. The value of this number indicates how many credentials for
that particular website you have saved in Passwordstate.

.
Passwordstate wa IMDb: Ratings, Reviews, and Whe X =

4 C @w @ & imdb.com/?ref_=nv_home m A _"‘"ll * O

m = Menu All » | Search IMDb Q IMDbPro Watchlist Sign In

Up next

()

s

s

Browse trailers >

If you only have one set of credentials saved for the webpage, then the browser extension
will automatically form-fill that Username and Password for you when you attempt to log in
to that page.

If you have multiple credentials saved, then you should click the browser extension icon,
select Show Matching Logins and then choose the appropriate login to automatically form-
fill:
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A A
A

W Passwordstate uild 9577)

0O
& Passwordstate Web Site
B Generate Password )
&a Show Matching Logins (3) »
A, Preferences »
@ !gnored URLs (2) »
@ Report Site Issue
©Q SyncNow  (sync scheduled in 58 minutes)
9 Help

& Logout: Click Demo

Fam-aEe i m TRy

Each login you have saved for the site shows the Username, the Password List where it is
stored, and also the Description. This will help you determine which credential you should

select.
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P A pa G

4 Back

«» Show Matching logins
Please select the credential to login withj

imdb.com

#’
. IMBB oo onal Website Logins
IMDb Sign-In

IMDb Sign-In

imdb.com

MOb e sonal Website Logins
IMDb Sign-In for Sales
imdb.com

IMDb

Personal Website Logins
IMDb Sign-In for Support

b v

If you need more information about each Password Record, you can click the advance arrow
which will take you to another page with more details about the credential:
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P A o *
4 Back

moe imdb.com

Username:

Password:

SEENNNNNNNIRNRNIRRES L& o

Description:

IMDb Sign-In

URL:

https://www.imdb.com/

Password List:

Personal Website Logins
Map Website Fields

On this page, you can copy the Username or Password to the clipboard, toggle the visibility
of the password, or click the link icon next to the Username field which will open up a new
browser tab with the Password Record open in Passwordstate.

The MAP Website Fields button is discussed later in this manual.

Web Authentication Passkeys (beta)

The Browser Extension can act as an authenticator for websites that support W3C's Web
Authentication (WebAuthn) standard.

Create and Register a Passkey

To create and register a Passkey, you must have an existing record for the website in
Passwordstate that does not already have an associated Passkey.

Additionally, the Browser Extension must also be unlocked/authenticated.

When the above conditions are met, and a supported website initiates a WebAuthn
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Registration Ceremony the Browser Extension will show a pop-up dialog offering to save the
Passkey.
Note: Records that already have a Passkey will not show in the drop down.

Authenticate with a Passkey

Similarly, when the Browser Extension is unlocked/authenticated and a supported website
initiates a WebAuthn Authentication Ceremony then a pop-dialog will offer to login using a
Passkey.

Deleting a Passkey

If you wish to delete or replace a Passkey, you will need to clear it via editing a record in
Passwordstate's core web Ul and also at the website itself.

Once the Browser Extension has synced these changes you will then be able to create and
register a Passkey for this record again.

Using the Search Feature

Another way to use the Browser Extension is to search for a website you have previously
saved.

When you find a credential via the search feature, you can either click directly on the
credential itself, which will open the website in a new tab, or you can click the arrow icon
which will open a new page with more details about the password record.
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P A 0 *

I} Passwordstate (Build 9577)

IMDB =

imdb.com

MO8 e sonal Website Logins
IMDb Sign-In

imdb.com

4
MOB  pcsonal Website Logins
IMDb Sign-In for Sales

imdb.com

MOB e sonal Website Logins
IMDb Sign-In for Support

Icon Overlay

The Icon Overlay is displayed by default in the Username and Password fields. If you have
mapped additional input fields then the Icon Overlay will appear in those fields as well.
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Passwordstate ms |MDb Sign-In X -+

d C @ o & imdb.com/ap/signinZopenid.pape.max_auth_age=08&openid.return_to=https%3A%2F%2Fwww.i.. | T@ A EEI * B =

Sign-In
Email
|

Log in as

imdb.com
Db
IMDb Sign-In

imdb.com
IMDb
IMDb Sign-In for Sales

imdb.com
IMDb
IMDb Sign-In for Support

Close

Clicking on the icon overlay will allow you to choose which credential you want to log in with.
It also has its own search feature to make finding saved credentials easy if you have more
than 10 saved Password Records for that website.

Updating Passwords on a website

When you change a password, from within the website itself, the Browser Extension will
prompt you with Update Password? for the existing Password Record in Passwordstate.
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Search Product or Part #

PARTS & SERVICE  GLOBES, BATTERIES & ELECTRICAL  TOOLS & GARAGE  4X4 & ADVENTURE OILS&FLUIDS CAR CARE & PANEL It

Auto Club Card Member get up to 20% Off* Almost Everything. Shop Now

My Store: No Store Currently Selectd

Q B

WENEERVIPYSIEII? = Update Password? s

I Passwordstate

[
-

e Www.repco.com.au

Password List

~r. Click & Collect e N Same Day Delivery Buy Now Pay Later Repco Gift Carc
G“A Ready in 15 mins*® ¥6™e"  Within Skms* e Flexible Options® @ Now Available
Username
My Account Dashboard
Description
ahmln oain sco Australia
ﬁ My Garage E Order History e Personal Details Login | Repce Australia
Password g
.................... Q '
L
! Email Address a Password ! Saved Carts m

Products Brands

On Sale Repco
Parts & Service Penrite

Engine Oil Castrol

Car Batteries Ryco

Filters Bosch

Brake Pads Bendix

Spark Plugs Bowden's Own

Car Care & Panel Meguiar's

About Us

Repco Ignition

Show Your Card & Save
The Garage

Know How

Media

Careers

About Us

Events

Can We Help?

Store Finder

My Account

Frequently Asked Questions
Advertising Corrections
Product Recall

Corporate

Contact Us

To do this simply click on the Update button. Alternatively, you can click Later to not update
your password record within Passwordstate at this time.

One-Time Passwords

If you have any Password Lists configured in Passwordstate for the One-Time Password
feature, these OTP codes can be both copied from the Browser Extension and also
automatically form-filled into the website’s input fields.

™ Note: The setting Enable Form-Filling of OTP Codes must be enabled in Administration ->
Browser Extension Settings, and this will be disabled by default for a fresh install or upgrade from
a build prior to 9583. In addition to this, the password record must have a Website Field ID set for

OTP.

The first image shows the automatic form-filling of 3 fields from a Password Record, those

being,

1. Username, in this case the Email Address
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2. Password

3. One-Time Password code

@ N a
Username or Email Address @

Password

a0
»
1
3]
>
&
»
(]
"

1
3]
>
ad
»
")
"

eccccccccccccccce &Y

Please enter the two-factor authentication
Remember Me I (2FA) verification code below to login.

Depending on your 2FA setup, you can get the

code from the 2FA app or it was sent to you by

email

Or, use a backup code. Authentication Code:

e © [0 ]

Or, use a backup code.

« Back to

The image is a composite image showing the first screen, which automatically form-fills the
Username and Password. On clicking the Login button, the second screen is show with the
OTP Code automatically form filled. From here the Login button is clicked again to login
using the 3 credential elements.
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4 Back

word pres...

Username:

Password:

SEENNNNNRNN NN RERES

Description:

WordPress login for
URL:

Password List:

One-Time Password:

309849 19

You can also access all 3 credential elements by clicking on the Password Record’s advance
arrow. This takes you to the page with all the details about the credential. From here you
can copy any of the fields and paste them into the website’s input fields.

Ignored URLs

If you find the Browser Extension doesn't work as expected on a particular website, we
recommend setting that website as an Ignored URL. This will set the Browser Extension to
not interact with any input fields for the site and the Icon Overlay will be turned off.

If you have an existing Password Record saved for this site you can still click on the Browser
Extension icon in the top right hand corner of your browser, and select the Password Record
advance arrow and click on the copy icon next to the Username and Password fields to
manually paste into the input fields.
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d C @ [ & repco.com.au/en/login P A — [‘h » 0B =

My Store: No Store Cur « Back

Q =

Search Product or Part # W repco.com.au

Wish List
Username:
PARTS & SERVICE  GLOBES, BATTERIES &ELECTRICAL TOOLS & GARAGE 4X4 &ADVENTURE  OIL .
Your Shoppin
Password:
Auto Club Card Member get up to 20% Off* A

.................... N

;‘ 3 Click & Collect =, Same Day Delivery e Buy Now Pay Lat Continue Shog 1

PA Ready in 15 mins* ¥o™5" Within 5kms* Flexible Options* Description:
Login | Repco Australia

HOME >

URL:

https://www.repco.com.au/

Password List:
Returning Customer Create an Acc: | Personal Website Logins

Map Website Fields

Feedback

Log In Forgot your password?

Your password needs to be between 6 to 20 characters. It
will also need to contain at least one (1) number, one (1)
upper case letter and one (1) lower case letter. Special
Characters are NOT allowed.

When browsing to a website set as an Ignored URL your Passwordstate Extension icon will

turn Blue. You will also see an ignored URL menu in your Browser Extension as per below
screenshot:
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I} Passwordstate (Build 9577)

O
& Passwordstate Web Site
@ Generate Password »
«a Show Matching Logins (1) »
9, Preferences »
@ Ignored URLs (4) b
© Report Site Issue
A8 Sync Now (sync scheduled in 30 minutes)
9 Help

& Logout: Click Demo

In the screenshot above, there is a counter on the Ignored URLs item with a value of 4. This
value is a combination of any personal Ignored URLs previously set, and any that your
Passwordstate Security Administrator has set from within the Passwordstate Administration
area.

When clicking on the Ignored URLs menu you’ll be taken to another page showing all of the
URLs the Browser Extension is set to ignore. On this page you can delete any URL in your
own Preferences by clicking on the X to the right of the entry. Entries without an X to the
right are System Wide Ignored URLs set by your Security Administrator. These can only be
removed by your Passwordstate Security Administrator.
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4 Back

@ Ignored URLs

Only personal ignored URLs can be deleted
(System Wide Ignored URL)
(System Wide Ignored URL)

& repco.comau

Linking Multiple URLs to one Password Record

Linking Multiple URLs to one Password Record has multiple uses. The first is where your AD
Account is used to login to multiple internal websites. In this example you can use the one
Password Record linked to URLs for each of the internal websites.

A second use is where some websites use multiple URLs for the login process. As an
example, a website may use one URL for the Username input field and a separate URL for
the Password input field.

Copy or Email Password Permalink
Copy or Move to Different Password List
Delete

Expire Password Now

>
o

Filter Recent Activity on this Record List Administrator Actions...

Link Account to Multiple Web Site URLs
Send Self Destruct Message
Toggle Favorite Status First

o
£

. . S 1P Add D ipti
View & Compare History of Changes Name Hrname ress escription

View Documents

w

Q
VPO FS4EOD00

Web APl Account .
View Individual Password Permissions View Password | View History

View Password Reset Dependencies

h
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In this situation you can still have the one Password Record but link it to multiple URLs.
When saving the Password Record the primary URL will be for the Username input field. The
second URL can be added by navigating to the Password Record in Passwordstate, selecting
the Action Icon and choosing to Link Account to Multiple Web Site URLs.

Web Authentication Passkeys

The Browser Extension can act as an authenticator for websites that support W3C's Web
Authentication (WebAuthn) standard.

Create and Register a Passkey

To create and register a Passkey, you must have an existing record for the website in
Passwordstate that does not already have an associated Passkey. Additionally, the Browser
Extension must also be unlocked/authenticated.

When the above conditions are met, and a supported website initiates a WebAuthn Registration
Ceremony the Browser Extension will show a pop-up dialog offering to save the Passkey.

B Passwordstate

WebAuthn.io

Search

A demo of the WebaAuthn specification

I webauthr i I

Sedert Record to Save Pasikey

WebauthnUser n

[ et [ 5o |

Padswardatate List

Note: Records that already have a Passkey will not show in the drop down.

Authenticate with a Passkey

Similarly, when the Browser Extension is unlocked/authenticated and a supported website
initiates a WebAuthn Authentication Ceremony then a pop-dialog will offer to login using a
Passkey.
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@ Passwordstate

WebAuthn.io

Search

A demo of the WebAuthn specification

I wabauthn o ]

Sedest Recodd 1o Lagin with Pastkey

w

Webauthnlser a2
Passwordstate List
Advanced Settings

Warning: Logging into a website will increment the Passkey internal counter as per the WebAuthn
specification. Some websites choose to compare the count value from the previous successful
authentication, and then deny access if they are out of sync. If you are restoring data from old
backups this can cause this issue, and will require using a recovery method for the website to re-
create the Passkey.

Deleting a Passkey
If you wish to delete or replace a Passkey, you will need to clear it via editing arecord in
Passwordstate's core web Ul and also at the website itself.
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I &2 Edit Password

thin the "Persenal Website Logins® Password List (Tree Pat

website fields url matching

| Password Generator 15 Character Passwords =

: Daseword Strenath ¥ comoliance Strepath e e e W

Save Cancel

Browser Extension Settings

There are various settings within Passwordstate which governs how the Browser Extension can be
used. These settings can be configured per user or System Wide.

Browser Extension Per User Settings

In the Preferences Screen, located on the browser extension tab, you can find settings for
automatically logging out of the Browser Extension, clearing the clipboard of data on a
schedule, and also for ignoring certain URLs.
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o
a

Passwordstate ves euidssr) Search Passwords or Hosts o

‘ PASSWORDS ‘

& Preferences

Passwords Home
» 77 An Bample To modify your preferences for Passwordstate, please make changes in the relevant tabs below, then click on the ‘Save' button.
4 = Browser Extension Manual

passwords tab hosts tab miscellaneous color theme ntication options mobile access options
Preferences

Please specify settings as appropriate below for the Passwordstate Browser extensions. Once your extension is installed, all you need to do is login to Passwordstate, and the extension

Address Book will auto-configure itself.

Preferences

T Extension Logout Settings
Email Notifications

Please specify settings below for automatically logging out of your Browser Extension.

Automatically log out of the Browser Extension when you close the browser:

OYes ®No

Automatically log out of the Browser Extension when your computer has been idle for (x) minutes:

0 I{Senmg to 0 disables this feature)

When triggering a ‘Copy to Clipboard" event in Passwordstate or the Browser Extension, allow the Browser Extension to automatically clear the clipboard after (x)
seconds after the event: (You must have one of the Passwordstate browser extensions installed for this functionality)

lo J (setting to 0 disables this feature)

Ignored URLs

With Ignored URLS, this will prevent prompting to save login credentials for a web site, automatically form-filling the site, and displaying the icon overlay on fields on the site.

[ Add
Enter the base URL here e.g. mypasswordstate.domain.com

Actions  URL
T
(]
(-] repco.com.au

Clear Al Ignored URLS

Save Save & Close

You can delete individual Ignored URLs by using the Action Icon for individual entries or by
clicking on the Clear All Ignored URLs button.

System Wide Settings

Your Security Administrators have access to a number of configuration options under
Administration -> Browser Extension Settings. These settings relate to;

e Browser Extension Settings
e System Wide Ignored URLs
e Users allowed to use the extension, and,

e Prevent users from saving logins.
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(o} ‘ B ‘ (] ‘ 2 Click Demo

U

Search Passwords or Hosts ...

Passwordstate vos euidosm

ADMINISTRATION ‘

4 €3 Passwordstate Administration

£Q Account and Host Discovery
h Active Directory Domains
4 Auditing

|£ Auditing Graphs

A Authorized Web Servers
& Backups

® Bad Passwords

[>] Browser Extension Settings
@, Brute Force Blocked IPs

4 Email Notification Groups

W Email Templates

[ Emergency Access

A Encryption Keys

O Error Console

[=* Export All Passwords

& Feature Access

£ Host Types & Operating Systems
[2 Images and Account Types

@ License Information

W password Folders

B Password Generator Policies
= Password Lists

BB Password List Templates

B Password Strength Policies
o Privileged Account Credentials
2 PowerShell Scripts

49 Remote Session Management
|2 Reporting

8% Security Administrators

B Security Groups

¥ System Settings

8 User Accounts

£ User Account Policies

@ Browser Extension Settings

Use each of the appropriate Tabs below to indicate various Settings, which URLs are ignored by the Browser Extension, which users are
allowed to use the Extension, or which users are not allowed to save new logins.

I browser extension settings ignored urls allowed to use the extension prevent users from saving logins

Browser Extension Settings

Please specify general settings below for the behavior of the Browser Extension.

Automatically log the user out of their Browser Extension when they close the browser:
OYes ®No
has been idle for (x) minutes:

Automatically log the user out of their Browser E ion when their

0 (Setting to O disables this feature)

If you need your browser extensions to communicate to a different URL compared to your main Passwordstate URL,
please specify it here: (in the format of https://mypasswordstate.com). This must also be the same database you're
communicating with, otherwise encryption/decryption will not work with different encryption keys

Various menus in the Browser Extension navigate users back to your Passwordstate Web Site. Please select below which
URL you would like to use for this purpose:

O Alternative URL Specified Above @ Base URL Specified on the System Settings page

Enable Form-Filling of OTP codes:
@ves ONo

Save

Web Site Field IDs

The button below can be used to clear the Username and Password Field ID values, for all password records used with the
browser extension, for all Shared Password Lists.

For more details of this feature, and other means to clear/fix Web Site Field IDs, please refer to the Browser Extension Manual
under the Help Menu

Clear IDs

If you believe there is a system setting preventing you from saving, using or logging into our
Browser Extensions please contact your Passwordstate Security Administrator. More
information on the Passwordstate configuration options for our Browser Extensions can be

found in our Security Administrators Manual.

Detection and Advanced Functionality

When first saving credentials into Passwordstate, the Browser Extension will not save any
website field ID's for the record. This allows the extension to form fill the username and
password based on the in-built input detection which mitigates against websites that use
dynamic field IDs.

The field ID's are only necessary for the OTP and Generic Fields or for websites where the
extension does not form fill the username and password as expected.
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Edit Password

Please edit the password below, stored within the 'Personal Website Logins' Password List (Tree Path = \Browser Extension
Manual).

password details notes security website fields url matching

The Browser Extension for Passwordstate uses the 'names’ of the HTML elements for form-filling. If you need to manually
change these, you can do so by modifying the values below.

'! If the Usertlame and/or Password field ID values are left blank then the extension will do its best to search and fills these.
However, for OTP and Generic Fields the field 1D values must be correct or form-filling of these fields will not occur.

UserMame Field 1D:

Password Field |1D:

CTP Field 1D:

Generic Field 1

Generic Field 2

Generic Field 3

Generic Field 4

Generic Field 6

Generic Field 7

Generic Field 8

D
D
D
D
Generic Field 5 1D:
D
D
D
D

Generic Field 9

Generic Figld 10 1D:

If you find you are having issues with automatically form-filling your credentials for a
website there are a couple of ways to fix this.

First you should confirm that you still have Enable Auto-Fill selected. This is found on your

Preferences screen:

4 Back

4, Preferences
Enable Auto-Fill  fi—
Enable lcon Overlay

Default Password List

\Browser Extension Manual'\Parsonal Weh

Default Password Generator

Default Password Generator W
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Next, check if the website you have browsed to has an Ignored URL set under either your
preferences, or has been set globally by your Security Administrator. Refer to the section on
Ignored URLs in this Manual for more information.

Finally, try mapping the website fields either manually via editing the password record or

using the Map Website Fields helper tool in the extension to override the in-built input
detection.

Mapping Website Fields

As mentioned above, occasionally you may be faced with a particularly hard website where
our Browser Extension does not automatically form-fill.

In this situation you can use additional functionality built-in to the Browser Extension to
correctly map the website Field IDs which may help depending on the website. To do this
select the Password Record in your Browser Extension and click on the arrow icon to open a
new page with more details about the Password Record. From here click on the Map
Website Fields button,

== [MDb Sign-In b

& imdb.com/ P A E.B » B

4 Back

me imdb.com

Username:
Sign-In @
Email Password:
[ ) e ——— @,
Password Forgot your password? Description:
m MDb Sign-In
URL:
Sign-In | https:/iwww.imdb.com/
(] Keep me signed in. Details ~ Password List:
Personal Website Logins
New to IMDb?

Map Website Fields
Create your IMDb account

Help Conditiens of Use Privacy Notice

© 1956-2022, Amazon.com, Inc. or its affiliates

This will open the Passwordstate Website Field Mapper dialog. From here it's a simple
process of mapping each input field;
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W IMDb Sign-In x o= Bs

& imdb.com/ P A E‘B » B =

IMnh Passwordstate Website Field Mapper

To map fields from the website you are currently visiting to fields within
Passwordstate, please first select the appropriate Passwordstate field, click the

. Pick Field button, and then click on the appropriate field on the website.
Sign-In o
Passwordstate Field: * Website Field:
Email »
Password hd ap_password
m -

Password Forgot your password? ¢

‘ Sign-In | o

[ Keep me signed in. Details ™

New to IMDb?

Create your IMDb account

Help Conditions of Use Privacy Motice

©1956-2022, Amazon.com, Inc. or its affiliates

1. Selectthe type of Passwordstate Field to map,

2. Click on the Pick Field button,

3. Move the mouse cursor to the input field, in this case the Password input field on the website
and click on it to select it,

4. Repeatthe process for all required input fields,

5. Click the Save button

This will now save the correct website Field IDs, for all input fields you have selected, to the
website fields tab for that Password Record.

Clearing Website Fields

If you find you are having problems with multiple Password Records not automatically form
filling, you can clear the username and password website Field IDs for all Password Records
in a Password List. This doesn’t affect the credentials, only the associated Field IDs that
have been recorded and stored on the website fields tab for each Password Record.
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To clear all the website Field IDs, for all Password Records in a Password List, simply login to
Passwordstate, navigate to the Password List you want to perform the action against and
click on List Administrator Actions..., then click on Clear Web Site Field ID Values,

Passwordstate voseuiassm

PASSWORDS |

cJ | 8 clickpemo | ()

= N
QR+ N Q @ :ii Screen Options
P Passwords Home
» T An Bample ) Personal Website Logins OFavorite @A Site Location (internal) @ Private List (Admin Access) % Guide
[l - = 2rowser Extension Manual Add | Documents(0) | Permalink | Grid Layout Actions.. ~  List Administrator Actions... <
2 . Actions  Title User Name Description URL Password Password password Last Updated
3 Businass Systems Strength
» T Customers &
9 - T T T T T
» T Infrastructure httpsy7 b
- B § DS/ANNAMADE s semsnsens
b = Bersonal Password Lists imcb.com IMDb Sign-In omy L8 8 & 8 4

E5 packup Accounts
imdb.com

Prime Finish

L]
o
© imdbeom
L]
L]

repco.com.au

Add | Documents (0} | Permalink

Ch Recent Activity @

Date Activity UseriD
Password
107/ 2:41:30 PM
18/07/2022 2:41:30 PM Updated

Password Screen

18/07/2022 2:41:19 PM
Opened

Password Screen

18/07/2022 2:22:04 PM
Opened

Password Screen

18/07/2022 2:06:11 PM
Opened

Password Screen

18/07/2022 2:04:24 PM
Opened

Password

5/07/. 12:09:27 P
15/07/2022120927PM Lo

Grid Layout Actions...

IMDb Sign-infor _ httpsi//wwwimdbc ...

om/

e s e e
IMDb Sign-infor  httpsy/pwwwimdbe ..,
om/

IR 2 2 22

Account - Prime h primef

Finish Car Care inish.com.au/

L8 8 & 8 4

hittps://www.repco.
com.au/

Login | Repeo
Australia

e de v 15/07/2022 10:04:52 AM

Al List Administrator Acti
List Administrator

PASSWORD LIST ACTIONS

E
Rist
Name #1 =

e

! . ' History
@ Clear Web Site Field ID Values

3 Convert to Shared Password List

€ Delete Password List

) ) i History
Password List Properties
" History
History
' History
(4] Have I Been Pwned Compromises
(4] Password Strength Report R e

Security administrators have the ability to clear all username and password website Field IDs for
Shared Password Lists via Administration -> Browser Extension Settings -> Website Field IDs,

Web Site Field IDs

The button below can be used to clear the Username and Password Field 1D values, for all password records used with the

browser extension, for all Shared Password Lists,

For more details of this feature, and other means to clear/fix Web Site Field 1Ds, please refer to the Browser Extension Manual

under the Help Menu.

Clear 1Ds

URL Matching
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You can specify the URL Matching option for each individual Password Record in
Passwordstate. This is particularly helpful in instances where the Username and Password
input fields are located on different URLs.

There are 3 URL Matching options available, Starts With, Base Domain and Host Name with
the default being Starts With which should cater for most situations.

Edit Password

Please edit the password below, stored within the "Personal Website Logins' Password List (Tree Path = \Browser Extension
Manual).

password details notes security website fields url matching

The Browser Extension for Passwordstate uses one of following URL matching options for form-filling this record:

URL Match Option: @® starts With O Host Name O Base Domain

Starts With: the website URL must start with the record's URL
l.e. contoso.com/forums will match contaso.com/forums and contoso.com/forums/login

Base Domain: matches against top-level domain and second-level domain of the record's URL.
l.e. contaso.com will match mail.contosa.com and login.contoso.com

Host Name: matches against the host name and port number (if applicable) of the record’s URL

l.e. contoso.com:84 14 will match contoso.com:8414 and contoso.com:8414/path
l.e. sub.contoso.com will match sub.contoso.com and sub.contoso.com/path

Save Cancel
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